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Adobe Photoshop

1.1 Introduction of Adobe Photoshop
(TS BT T aRke)

Photoshop is software for image processing. With this you can manipulate your picture; either
scanned or otherwise inserted from the computer, to such an extent that you would sometimes
forget which picture you started off with. But, this is not the only purpose of the software, you can
use it create better looking pictures and art works with text and other graphics to beat any other
similar software in the market.

HICTYTY T S URIRAT AHCR B | 39 Yeiiaed # fhefl ek a1 391 S w4 & T &1 a1 dvegex
A 39S fHar a1 81 DI U 7 IS Hgelc IR Whd & | 39D Fergdl § fhe faer 37 omu g9 Fax
T b & TSTAPT AT TS WY &I T b D b TR A MU YRATT B Y | BISIRIT AHEIAR BT
I B TAN & AL 9fed MU TR AR A Whad B A JeR o ® A R Ferr wraf B aer
DA & IR H [P 377 FAM FIFedIR B dIc 1 & oy |

Adobe Photoshop is a raster graphics editor developed and published by Adobe Systems for macOS
and Windows. Photoshop was created in 1988 by Thomas and John Knoll.

TSI BISE T IReX Thad Ufser & 19 8% oy @R fiore & folv teie Rved g1 fasfig ok
gfeeter fobar AT B | BICINY 1988 F ATAYT 3R Sif Al §RT 94TAT AT o7 |

1.2 Features of Photoshop (®erRiiy I favivar)

1. InPhotoshop, Photo editing is performed in lesser time and with little effort.

B ¥ Bler UfefET o9 99g ¥ 3R o9 W § WeE & Srdl 2 |

2. It enhances or changes the colour of an image by adjusting the brightness and
contrast, colour balances and saturation levels, curves etc.

TE TAD IR BERT, T AT AR TG oldel, Hd 3N Pl FARNTT RSP SHol B T
BT FETAT AT I B |

3. Cropping images.
U Bl BT BHRAT 2 |
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4. Repairing flaws in the image, such as red eyes or dust displays on the lens of the eyes in any
image.
ST B HEHAT BT S BRAT B, oI, A W ST W SfiEl B ol W AT N AT ¢ BT TR
B |
5. Drawing on an image with a pen or pencil.
U U 9 R o W) SIE T ae |
6. Adding text to images.
SOl A e TS |
7. Removing people clip or any objects within an image.
3 @ WioR Afddar @) e o sifstae &1 ger |
8. Organizing photos for quick access.
fdge Tt o)A & oy BIel sgaferd &R |
9. Publishing images online or send via email.
U BT ATTcITgT UfeeteT BRAT AT SHT B ARIH | WolT |
10. Layer effects preserve the original state in an image while manipulating another version of it
through another layer; we can add as many layers as we need.
TR SHaC Udh SHOT # ARG e Bl I8 W § STdfd SN oIk & ARIH H $Hd gaR qoid
BT ANYelc Hed §; B fa STevd 81 Sal oRR I 9o © |
11. 3D effects incorporate completely new and improved extents to an object by introducing
new 3D reflection, icons, and draggable shadows.
331 gHhac Y 331 Ruclaer, Mo, 3R Wi T A7 AT &I U T B eifesiae # @ e
J Y 3R JER faR &7 wmiie axd 2|
1.3 List of Photoshop versions (®CEig qoiHr @t fore)
Photoshop Photoshop5 Photoshop CS3 & Photoshop CC(2017)
Photoshop1l Photoshop5.5 CS4(2007) Photoshop CC(2018)
Photoshop2 Photoshop6 Photoshop CS5(2010) | Photoshop CC(2019)
Photoshop2.5 | Photoshop7 Photoshop CS6(2012) | Photoshop 2020
Photoshop3 Photoshop CS(2003) | Photoshop CC(2013) Photoshop 2020(21.1)
Photoshop4 Photoshop Photoshop CC(2014) Photoshop 2020(22.0)
CS2(2005) Photoshop CC(2015) Photoshop 2021 (version 22.4.2)
1.4 Photoshop 2021 (version 22.4.2) (BT 2021)

Adobe has released the new version of Photoshop CC (version 22.0.0) that comes with exciting new
Al features for artists, designers and photographers. The Smart Portrait Neural Filter lets you control
facial expressions of the subject in the photograph. You can even change their head direction, light
direction, gaze, and hair thickness.

(2)
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TSI J B AR (@S9 22.0.0) BT 4T goi9 oM fHar § S dallaRi, fSOsRI &R Bremmsi & forg
AMFS 2 T3NS Gawmsli & | A1ar B | e UIge =Rl fheey MU BIERms H vy & Jgx & wal &r
RIS ®= <1 21 3 S RR @ fewm, uerer @) e, ched! iR a1l @1 diers o 9go dahd B |

The colorize Neural Filter can turn any black and white photo into a colored photo. The pattern
preview feature gives you a real time infinite preview of the pattern that you're creating, thus
allowing you to create seamless patterns.

FHoRTge <R fheex fhell Ml <id U ®ge wiel & 9 wier § 9ad waar 21 Yo Mgl wiR 3rud!
MU ERT I91Y ST ¥ Ut &l aRafds a9g 3 oFd Wieg a1 ©, 39 UHR 3MMUP! Feol Ue a9 Bl SrgAfa
Il 2 |

Live Shapes are now more enhanced and you can modify them even after rotating. You can also reset
Smart objects to their original form no matter how much you've transformed them.

W18d WY 319 AR AH I 8 T 2 3IR T IT AW & a8 1 WAT X G ¢ | AU Fe 3ffeolae
Bl 7D Hol WHY H AAS W PR Fhdl &, Wel 81 MU I fdba 1 W gaa faar 81|

1.5 Photoshop CC (2017) (®eriia A=t (2017))

This version allows users to sync multiple devices and share and save files on the cloud system.
Added features in this 14th version of Photoshop includes Smart Sharpen, Camera Shake Reduction
and Intelligent Up sampling.

IE Ioi YR Bl 3 Fagdr B R a3 iR Forss Ried W w1Egal & |80 &3 3k § & Bl
AT AT © | BICRINT & 59 143 Toid H SiIs ¢ BHad § WE A0, A7 96 Rsaed iR seforie o
Suferr wfae €1

1.6 Adobe Photoshop CS5 (TSi9 B Hwwds)

Adobe Phototoshop CS5 is a popular image editing software that provides a work environment
consistent with Adobe Illustrator, Adobe InDesign, Adobe ImageReady, Adobe Fireworks, Adobe
Bridge, Adobe Device Central, Adobe Camera RAW and other products in the Adobe Creative Suite.

TR WICRIY Hivds Th s gael URfST WuediR 2 O §' & Wi TSl SoRgcl, USIg
SARSOITEH, TSId SHuNS! TS HRRadd, T v, Teg fearsy dgd, Ted &1 3f dor geie fihufed ge
P Y TR R BRI DR Pl a0l YT Bl 2 |

1.6.1 Installing Photoshop CS5 (BICI¥ITT HIYH 5 SRTIel BN

Here we will take a look steps installing Adobe Photoshop CS5 into your computer system...

I8l §H AMUS B HEcH H YS9 BT HIUH 5 ST B & HEH Qi

=  First Insert the DVD into the CD/DVD ROM
drive case or Double click the setup file if
downloaded. Doing that you will have a
look like this...

REC I SASICISIINC IESEC I S G IS IC IS
TAC BN AT WY B Bl S fIAd D |

= Now read the software license agreement

(3)
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by Adobe as term and conditions as installing and then using the software, Proceed by clicking to
Accept button; and then

I TS FRT WiTCR AgHd Wik ufey Td ¥ U Heed 3R iR |ivedaR &7 SUANT &< g,
Accept 97 R e $RD 3T g91; 3R R

Provide the serial key located at back of DVD wrapper or by email you received from the Adobe
store; and then Choose a specific path where you want to keep the installed files in your
computer system; and then

SN YR B G Rerg a1 MUPT T8 WR ¥ WG 7 gRT AIRTa 3" dage N iR iR
TR a1l g+ ST8T o1 U HRex RiRed ¥ g=cles WiIgall & 3@l aEd §; 3R fiw

Click to Install button to move ahead.

I ge7 & oIy §%id g9 R s &Y |

Here we see the progress bar running towards the finish end to make sure and to show the
progress of installation of the application; and finally

gl &9 UAde B AT Bl GARad & & foy TN aR @7 $ift| BR @) iR ¥ B gU <Wd
3R 37=a:

Click to Finish button to finish installing the application.
URTH I BT S¥ETol BYd & fo7U Finish se7 W faeme &9 |

1.6.2 Starting Photoshop CS5 (BT Wwsis TR= $H=1)

After Installing the Adobe photoshop, here we will see the steps for opening Adobe Photoshop CS5
Application...

TSId BICEig JUH5 AFCdIR Bl SRSl B & g6 I W B & foIU 3MUhl 30 3T BRA1 SN

e fafer fe=faRaa 21

Click either the shortcut icon at the desktop; or

SYHT WR Tche ASHT R fFeld B, AT

In Windows 7, Go to Start>All Programs>Adobe> and Select Photoshop CS5 in your computer
system.

faet 7 #, W€ > oife o > e > R 1Y iR S hRjex Red § wieei CS5 deae & |

(4)
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Doing so you will see the splash screen of the application opening.
U1 R | 3T YD @i o Telel BhiF Q@i |

1.6.3 Photoshop CS5 Interface (®IC¥IT WTH5 STIBN)

In Photoshop CS5, You create and manipulate your documents and files using various elements, such
as panels, bars, and windows. Any arrangement of these elements is called a workspace.

HICRIY HgHs 7, Y 39a, IR 3R fder o fafi=1 gfom! &1 SuanT axa U+ STagie 3R BIsall &l
T & 3R ST AR $d & | 57 Yfere! 1 fahell 0 awel &1 ahwd $8l S 2 |

= The Menu bar is the top most horizontal bar in Photoshop window that contains all the menus of
Photoshop, such as File, Edit, Image, Layer, Select, Filter, Type, View, Window and Help.
] IR BRI RS ¥ e SR Siores O & R Brerei ¢ i i g9 f o R wiee
(5)
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2.0 Introduction to CorelDraw
(@R $T TH UR=)

CorelDRAW Graphics Suite 2021 is a professional graphic design software for creating graphics and
layouts, editing photos or designing websites. This suite includes the bitmap-image editor, Corel
Photo-Paint as well as other graphics-related programs.

CorelDRAW Tfthad g 2021 Ifhaw 3R <lelSe a9, Hiel Ufee ax a1 dearse Rumss & & fog
Th WRIR Whd fEqEd dffcdRk 2] g9 ¥ H fdchiu—saa ufecy, @Ra wic-Uc & A—WRT 3=
TIftheRT | AT URmE wnfie €

Bitmap-image editor means the images are created in the form of bitmap, Corel photo-paint, a
powerful image-editing application in which you can quickly and easily retouch and enhance image
photos, the other set of graphic programs use vector graphics where the graphics are composed of
mathematical curves.

fJeiu—siol UfSex &1 Addd & 6 01 fiehu & wu & i 9918 oIl 8, &R Blei—ue, Tdb IRpamed
AU Uit € fT9d 3y g89T Biel T STeal 3R MMl 9 g 3R Mapyd -1 ddbd o, Ulfthed
AT &1 GIRT U e’ Albad Pl SUANT HRAT & STl TNfthad IO Hal | a1 Bl ¢ |

The latest version is CorelDraw Graphics Suite 2021 and was released in March, 2021. This is also
designed to edit two-dimensional images such as logos and posters.

DR g UMpad G 2021 TI9aH doid @, AR A1, 2021 H SR fBAT AT o | §9 @R &R URex S
T3l gHG BT Ufee oxa & fow Y fesms far mar 2

Vector graphics and bitmaps (@aex Tfbad 3R fchw)

The two main types of computer graphics are vector graphics and bitmaps. Vector graphics are made
of lines and curves, and they are generated from mathematical descriptions that determine the
position, length, and direction in which lines are drawn. Bitmaps, also known as raster images, are

(123)
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composed of tiny squares called pixels; each pixel is mapped to a location in an image and has
numerical color values.

FYeR H TANT B ATl UMMhad &I YHR P 81T & Usall ddek Alfhad Ud v fdcHu Ufthad | dJaex
Tfhad oS Td &d &1 Fegdl ¥ a9 8 8 forg IR g3 & 9erdr 3 owE, $ars gd dreied &
2 H TGP $T fhar oar ' wefe iy s9 s & wemar 9 AT 2 €| e Ueie @
e Tar o T B @ % teh hREd der 9eg ueT &1 T Bl 2

2.1 Features of corel Draw (®Rd §T & W)

With corel draw 2021 help you complete many tasks more easily and in less time. Here are the

features of corel draw 2021.

BRA FT 2021 B AGE W MY H3 BT Pl TG TAFT F AR B F99 # QR FR A& 8 | DR $T 2021
P BITR 39 UPR 2 |

1. Perspective Drawing (q=fufdeq grE)

In Corel Draw 2021, The Perspective plane is used to create three-dimension images. You can draw
or place existing objects onto the perspective plane to create 1-point, 2-point, or 3-point perspective
3D-looking objects.

Corel Draw 2021 ¥, Perspective plane &7 SUa f-sa=H e a9m & forw fdar smar €1 ey
1—dge, 2—@ig<, I 3—@ig< Perspective 3S—fa@s arel difeide a9 & fou His@r sifelae @1
Perspective plane TR g1 & AHd I & A 2 |

2. Multiple Page view (Afcedd U1 &)

This is another new feature that CorelDraw 2021 introduces. You can fluidly move around objects
through pages and arrange pages easily. And it allows you to compare your design side by side.

I8 TP IR 7S fRIVAT 8 RO SRS 2021 U HRAT 2 | MY J=I & A 4 3ifeotae] & RN MR A A
qa PR FHA © AR J&I BT A F FaRIT IR AHhd & | 3R I AT U S8 & Arer—rer el
FRA BT JAFART T T

3. Export Multiple Assets at Once (T& WRI 3 YA T B

This feature allows you to export multiple pages or objects quickly and easily all at once in the format
you need, such as png, high-resolution jpeg, etc. Exporting multiple assets saves you time and makes
your work more organized.

One cool thing about this feature is that you can have different settings for your objects when you
export them, and you can still export them at the same time. For example, | want my orange object to
be in PNG format and the blue in JPG.

T8 G AUDT FAWIF BHC H TP AT Py &I AT Afeoide] Bl STeal iR R TaaUe R B
AT IAT B, S fF Dol S—RYTREE Sidisoll, 3Nfe | 3Fd THeH &1 Taqule & I IS J9
AT ¥ IR BT B NG FaRerd & orar 2

9 G & IR H TP <] 910 Ig © b Ofd AT ST YWUIC P © Al D TR AT Al 8l
Hadl €, 3R MY I8 U & F9I § UaUIE R Adhd 7 | Sarexy & forg, H =medr g f& Wy AR siferae
Gioaoll Brfe ¥ SR ar odeh & 8
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4. Easy of use (SUART # 3m4T+)

Many designers love CorelDraw’s simple and clean user interface because it’s easy to find the tools to
use. Most of the basic tools like shapes, crop tools, etc are easy to learn, CorelDraw also has a lot of
ready-to-use templates if you want to create something quickly. Templates are always helpful for
beginners.

%% AR CorelDraw & ¥Rl 3R We® YOR FeXHA BT THE IRA & R SHBT SUANT HRd THT oA
ST I B | Afddier 9P < S WU, BT T, AMQ B FHSET AEE &, IR NI Seal F HY 1
I & A1 PRA ST H 98 I 97 I THelC Bl & | SHelc BRI YOART Rl & oy HEETR 8 & |

5. Time-saving typography (F9d 9™ dTell SISURIT®Y)

Cut out the steps to creating head-turning typography with direct access to over a thousand Google
Fonts families in Corel Font Manager. The Google Fonts library makes it easy to browse, search, and
preview fonts, including many new variable fonts that you can use without having to install them.

Corel Font Manager U&% &SR ¥ 3% el HiT BiA B Y TR -+ & A1 de—cfT STgurImh!
T & =RON H BN HRAT T | T B AN § Hie DI IMATT I FST v, @ior, FR gataaia-
PR B G Bl 2, foed oe T IR wie wnfia & g o s=efa B 3 ST ax dad 21

6. Autofit page (@meifthe )

With the new Autofit Page feature, you can easily resize a page to fit its contents. Use the default
margin of zero, or enter a margin for a bit of

space between your design elements and the
edges of the page.

T Jifeifre g gfder & e, oy el us &
Fee Bl e FA & o TP MHR MAF I 98 Fahd 2| Y & fhlee AT ST ST &, AT
3o feare gferrel oiR U & fBaRi & dra o<l A1 S8 & foiy U Ao & o |

2.2 System Requirements for Installing CorelDraw
(PR $f STl B B forv Rived smazaedan)

e  Windows 10, 64-bit, with latest updates.

e Intel Corei3 /5/7/9 or AMD Ryzen 3/5/7/9

e Video card supports OpenCL 1.2 with VRAM 3 GB or more

e 4GB RAM (8 GB or more recommended)

e 4.3 GB of available hard-disk space for applications and installation files.

e 1280x 720 screen resolution at 100% (96 dpi),1920 x 1080 at 150%, and 2560 x 1440 at 200%.

e Internet connection is required to activate and validate CorelDraw Graphics suit, to receive
updates, and use online product features and content. The product can be used offline if you
connect to the Internet at least once a month to validate your software license.

PR $T UMb Y& BT AP 3R ARG B, IIST UG P 3MR 3iielg Icare Jlawmiil AR de<
BT SYANT B B U S F-Iae= Bl MaIGHhdl & | I bl Abellgd SYANT fhar ST Fohdr &
IfT T YT ATCRR AZHT BT AT BT & o 789 § $H F $F Uh R Fex-c I HAde 8
=
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2.3 How to install CoreIDRAW 2021 (®Rd $f 2021 DA SRT(A BN)

After downloading CorelDraw 2021 software, You can install them by using following ways.
CorelDraw 2021 SHFCdIR SIS B & 915, AT 4 TRIPI BT STINT PP I8 g~ B Ihd @ |
e Turn off anti-virus software (Note also turn off Windows Defender).
TE—aRRE AR d8 X (A I fSwwex &1 41 98 &)
e Extract the downloaded software.
SSTATS by Y HiFedR Bl Fehred |
e Run Setup to install the software, please continue Next.
e After completing all the steps click on finish button.
N T I IR PR S q18 BT 927 W fFds a |
When you install CoralDraw Graphics Suite 2021 then following tools are automatically installed.
9 3T BRA $f THad G 2021 IRE(A B & af FHfIRad <ot o & g=eidl & od &
e CorelDRAW 2021
e Corel PHOTO-PAINT 2021
e Corel CAPTURE 2021
e Corel Font Manager 2021

2.4 Getting Started with Corel Draw Graphics Suite 2021
(@RS $T THaT G 2021 & AT YB3 BRI

You can start Corel Draw Graphics suite 2021 by using following methods.

amg =1 faferal &1 SUAT #%a Corel Draw Graphics suite 2021 % &R |ad o |

Method1: In Window 10, Click on the Window Then following startup window of CorelDraw
button>Select Corel Draw  Graphics Suit 2021 will appear.

2021>CorelDraw 2021(64Bit)

Method 2 : We can also type Coreldraw 2021 in
Search box.

After few seconds following welcome screen appear
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3.0 Introduction of Adobe PageMaker 7.0
(TSlg USHHR 7.0 TH uReay)

Adobe pagemaker is introduced in 1985 by the Aldus Corporation on the Apple Macintosh. Adobe
Pagemaker 7.0 is a desktop publishing program, designed especially for individual professionals and
small businesses. It was released 9 July 2001. It is widely used by businesses for creating flyers,
posters and reports and printing them safely. Adobe Page Maker also helps export projects and
reports to PDF file formats and other formats supported by Adobe software.

TeIg USTHER BT 1985 H Apple Macintosh W Aldus Corporation §RT UST T 737 o1 | TS USTHER 7.0
T SWhE UfARRT Uum 2, R faey wu & @i WRIeRt @ik Bie arawamt & forg fesmss fvar mar 2
9 9 s 2001 B SR AT AT AT | SHRI ST FIART §RT AUG WY A T, URex iR Rure
M R 9= W wu 9 fic F & fow B Sar 21 vsE Iower MG Bied Bricl 3R TSl
AR gRT AT 391 Bre! # Wiotdel 3R R @f fafd o # ft #eq axar 2|

Adobe pagemaker latest version provides many useful features like you can tag PDF files. All texts
and graphics can be easily displayed on personal computers, PDA and Mac systems. Files generated
through Adobe Pagemaker software can be displayed on smartphones also with the new version.

TS UTHER oICRC gt s YA JRAETE IaH FRAT § O MY GG BISell Bl ST B Ghd & | Wl
CHRT 3R Wfhad & T el HRe, WY iR H6 Rived W Ml A Wi fFar o dadr 81 tee
USTHHY AFeqIR B AEgd U Icd~ BIgel AU doid & 1 Wehia W) 9 7ef¥ia & S dadl 2|

Adobe Page Maker online security features have also been updated to ensure that your data is safe
while desktop publishing, printing and sharing.

TS Ul WG H Siiers grem giawnsi &1 ff suee fFar war & aife aw ghied e o1 9@ 6 s
ufeaRiT, WfT SR A o= wHY oMU Ser YriAT B B |
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3.1

Benefits of using Adobe pageMaker software
(TS USSR HITCIIR BT SYANT HIA b )

You can create books, brochures and magazines by using attractive layouts in the pagemaker
software.

3T USTHAHR ATFEdIR | SAHYD IATSE BT SUANT HRS fhard, SR R UGN g7 Fobal ¢ |

In Adobe Pagemaker, You can use tools like rulers and grids to create your own professional
publications.

TSI USSR H, 31T 07 UIR UfeaAde a9 & oy Sk iR fire S ¢ &1 SUanT 3R Ao ¢ |
It helps with font management and provides variety in terms of font selection.
TE HiT YU H AaQ HRAT 2 R Bic T & A § fAfdear ge wxar 7|

It Ideal for creating complex documents and exporting them to PDF.
I8 e ST g9 IR I UIeIvh # gauie &< & foy armasef |

It is ideal for integrating texts and graphics from multiple sources like newsletters, web, print,
brochures, etc.

g Yufeled, 99, fife, TR s S & 9Ial 9 Save 3iR Wfha’T &I Tdhidd o & forg ameel 2
[t ensure easy integration with Adobe Acrobat, illustrator and Photoshop.
7 Adobe Acrobat, Illustrator 3R Photoshop @ Ter 3 Yaieheor JARad war 2 |

In Pagemaker 7.0, You can view your created documents on any device from anywhere.

USHHR 7.0 H, 31T AU IY T SIFGH BT iy ) s ) w8l 9 1 <@ Ao 2|

3.2 Starting Page Maker (UsHaR & &)

To start Pagemaker, do one of the following.

ISHEAR I YA B forg, 7 & IS U a1 o |

1.

In Windows 7, Click on Start>Select All Programs>Adobe>Adobe PageMaker 7.0 and Click it. or
fiere 7 3w’ R faddd dxd> i AIrE>TSIE>TSE YoMaR 7.0 Aelde 3 iR factsd X | a1
In Windows 10, Click on Window button->Select Adobe>Adobe PageMaker 7.0 and click it. or
eIt 10 ¥, famer 9e7 R s TR >TSI>TSE UoHaR 7.0 Helae N AR fadtd oy | ar

You can also type Adobe PageMaker 7.0 in Search box appear in the Task bar.

MU eRF R ¥ faw@rg <9 a1l 99 §fa # Adobe PageMaker 7.0 ¥ €18 $R AHhd £ |

Then Adobe PageMaker
7.0 splash screen will
appear.

After starting the Pagemaker select any required
Template which you want and Click it. Or Create a
New document. Or Open any Existing document.
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3.3 Adobe Pagemaker screen (TS1§ USSR IF)

The screen you encounter when you open pagemaker has the following option.

ST MY USTHAR Wield & ol 3 A Sl BhIF rdl 8, S9d Ui = ey gran &

1.

Title bar: It displays the name of your document. If you are working with a new document
and have yet to name it, then Bydefault displays Untitled-1.

TIEed IR: Ig 3MUd SIRAT BT A9 URId HRal & | AT 37 U ¢ SR & AT B PR I8 ©
3R af T BT A TN I B, A1 99 fewiee Untitled-1 9ef¥id &=am 2 |

Menu bar: It contains all the menus available in PageMaker. The menus are as follows - File,
Edit, Layout, Type, Element, Utilities, View, Window and Help.

AY IR TAH U] ¥ Suael w1 A B €| A 39 UaR § — WIsd, UfSe, Tiese, TS, Yeiiie,
Ffefadrs, g, fIer ok ged|

v File - This menu is used to manipulate your files. You can create, open, close, save, export and

import files with this option. The menu also contains command for printing.

B39 A BT SUINT 3MUBH! HIgell Hi Agele &= @ forg far Simar 21 oMy 39 fRAwed A
BIgel 997 Ahd &, Wil FAhd 8, 98 DY Fdhd 8, Jd R Ihd 8, TR Y Fobd & 3R gEe o
PR AH 2 | 39 9= 7 e & forg wHls ot 2

Edit - This menu contains options for cutting and pasting text and graphics.

- 39 7Y # SRe 3R Wihaxd &1 b 3R Ue(Rue™) o & foy fawey i &

Layout - Using this menu, you can choose to insert and delete pages. This also has the option
for inserting Column Guides.
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AMST— T A=Y BT SYANT TR, 3T YSiT BT T T4 (Iollc B APhd & | SHH AT BicH e
ST BT fadbou 1 Brem 2 |

v" Type - The options on this menu allow you to specify the size and alignment of your text.
Almost everything related to text is on the Type menu, including fonts, sizes, alignment, type
styles, spacing and indentations.

TIEU— 9 A & fAHcy MB!I 31U TRT & AMHR AR Terg-Hc & WRIHE () o @ srgafa
2T T TRe W G a9 Bie, 3MBR, TdsTHc, <lgU ¥esed, WRIT 3R gscvd fd,
TT3Y A R USRI BT 2 |

v"  Element - This menu contains options that affect graphic elements, such as lines, rectangles,
and ellipses/circle, as well as imported graphics images.

gferie— 59 & 4 W ooy wfa 8 € St mifhs ferie &1 gaifad o= € 99 & @rs,
NHSTed Ud Uferssd / |Afdsat, 12T 81 guics UTftha SO |

v'  Utilities - This menu is the gateway to the PageMaker plug-ins. It

Utilities | Wiew Window Hel

also contains Story Editor commands (to perform searches, Plug-ins >
replacements and spell checks) and options for creating tables of s -
contents and indices. S i
FRARET- 7 ¥ SRR w-gT B Y W ER @ wWe 31 s | Sl
TR R (wdis wd, dedie afs We Jd &) & forg) iR eda P

3 Pice T SeTT 999 @ fAdbed e 8 2| Sreors O

v' View - This menu is use to view the page at different levels of [view | window wer
. . ) ~  Display Master ltems
magnification. For example, you can see the entire page at once |- oispiay Non-Printing em= AR~

Zoom In o

with one option, or you can zoom a section of a page to twice its

Zoom Out e

actual size with another. This menu also contains items that can | Actueisze -
be turned on and off, such as rulers and grides. Entire Pasteboard shro
F— T AR B ST U B A wRE B AAfeTE R @ @ . "
ferg fopam Siram ¥ | SarEer & forg, omd ve & aR F wyof et @ v | e -
fOwey @& I < Ahd €, I1 MU B U1 & fhd) Jae &1 Uh Hide Guides
TR B A IRARAP AR BT A AR O BY GHA | G A H UG | rooomes Pt

amged A e § R aref SR 9 fhar o b 8, O werd iR ens Gt 1o B
s

v Window -This menu is used to control what you see in your window. For example, you can

turn on and off display of the toolbox, Colors palette, control [Window [ Help

palette, and a Style palette. You can also use Window > Plug- i:’:"ge'm"s

in Palettes command to show or hide palettes for installed Cascade

plug-ins. Hide Tools

ﬁ@__ 3 m ﬁ@ ﬁ Gﬁ' a@ﬁ % w W},ﬂ Wﬁ ?B' 1%‘]? w ]E'Ql Hide Control Palette sk
FHeled Yole iR U e Uole &1 a1 iR 48 &) Adhd o | 39 Show Layers g
Window > Plug-in Palettes ®¥T<s §~<ice &I 3 & oIy Ui me L Feges shos
B Ry a1 BUR & g ST @R awd 2 e

v" Help - This menu is used to display an index of different
topics on which online information is available.
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THU— 39 A B SUAT faf=r e &1 v gew ueRid axa @ forg fear onar @ M w

TS SIBR SUTE Bl 2 |

Standard Toolbar: Toolbar contains buttons that you can use instead of menu options to
perform common tasks.

WS TEEAR: TR # VN g9 BT € Sl 3N WHEI BRI Bl B & ol A Aded & I ST
PR FH & |

HEFIERREE L ST ER

Color Palette: Used to apply colors or to view the color of the selected character, paragraph, or
object.

|

=1=1

Por Yele: TN BT AN B AT TG Dedes, IS AT iTeoTde BT || [ swuter [ Catars >
I T B %"K’ T 2| FxiEm Tint: [100% =] |
k! [B<] (Mone]
Picture Palette: Contains a variety of art work in different EE:”H] ——
categories. You can insert any graphic from this palette in your = [Registration]
Elue =
publication by simply dragging it to the desired position. B cuen =&
. . . | B L=
AR dole: s fAfa= afrl # ARy sorefaa wfie Bkt 1 | e =
a5 dore F R o Wihe B o ufedua § dae aifd | e ==
I W digax AffAferd #* qad £ | B

Ruler: PageMaker provides two customizable rulers, which run horizontally and vertically
along your screen. You can set the rulers to measure in either inches or picas (picas are a unit of
measurement unique to typography. One pica is equivalent to 12 points, which is about 1/6 of
an inch).

TR, USTH®R Tl hRcHguIdd Bk U BT 8, S & MUd] ThiF IR ERivied R afdhd ®9 |
Td B | MY SR BT AT a1 39 A7 UpN & 999 & 7y e &~ Jhd 2 (e csaum & o

I FoRAE BT b SHTS B | U fIhT 12 Wige & SRR BT 8, Ol Uh $9 BT o 1/6 2)

Toolbox: The Adobe PageMaker toolbox offers all the desktop publishing tools you need to
design brochures, postcards, business cards, letterheads, or other publications in PageMaker.
To display and access the Toolbox, click on the "Window" menu and click on "Tools." The
toolbox will now be displayed. You can toggle between a visible and hidden toolbox as needed

to maximize your workspace.

TEla: TS USHaR godiad, JoiaR § dRR, UREHS, Ao Fre, oevesd I I ufedderd &
feoe & & forg amavas Al SWhety ufeddhed Tl USM aRal 2 | Codiad &I Hafdid iR gavd
@ fog, " 7Y R fRE W SR T W fOed W | gEdiad o1 Ui 8 Srgm |
I BRIES BT ABTH PR B AT Mawdd A IR TS codiad & dd SHTel I o & |

Page: In this page, you can easily place and arrange text, images and graphics to produce
documents such as newsletters, brochures and books or to attract readers.

IS 9 U H, U Yulcied, SRR IR fha S ST IR &R A1 UIedl Bl e dRA &
forg TRe, 89T QIR TIhaRT BT T & X Wohd & 3R FaRerd o Adhd 2 |

Control Palette: Adobe PageMaker's Control Palette is a versatile feature that you can use to
format and manipulate text and objects in your document. The Control Palette displays the

properties of a selected block of text or image, and enables you to adjust its settings.
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